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Studio Software Update 10.0.5 – Release Notes 

Previous Studio Release: 9.1.4 
Supported Equipment PC: Z370, Q470, W680 

Recommended PLC Versions (hardware dependent): See details in PLC/HMI Update 
Offline Studio Operating System: Extensive testing specifically performed on Win 10 and Win 11 64 bit 

  

Summary: 

All included Studio applications have been validated for compatibility with previously created Akrometrix Studio 
file formats. Files created prior to Studio 8.0 will not be readily usable with the Automated Report Generator or 
Batch Interface Analysis feature. Important bug fixes and added features are listed below. This list does not include 
all resolved bugs and added features. Known issues are presented with workarounds where applicable. Studio 10 
is built referencing updated external software components, requiring all update procedure steps to be run in order 
to function correctly. 

Update Procedure: 

PLC/HMI Update 

Studio 10 requires an update to the PLC for the AXP 2.0, AXP3, and PS600S systems including a PLC (PS600S system 
including an HMI screen seen on the front of the electrical cabinet instead of a Watlow CSL208 temperature controller). 
Owners of any other Akrometrix models may skip this step. Download and use PLC and HMI versions per the table below. 

Model Equipment Serial Number PLC Version HMI Version 

AXP 2.0 

<0413 1091 

0084 
0413-0440 (except 0433 and 

0437) 
2091 

0433, 0437 and >0440 2504 

AXP3 Any 3008 3007 

PS600S 
<0432 1014 

0084 
>0438 2014 

Further instructions for downloading PLC/HMI code and updating AXP 2.0, AXP3 and PS600S systems will be provided 
separately. 

Install Visual C++ Redistributable (v14) 

- Copy the provided file (VC_redist.x64.exe) to the equipment PC desktop 

- Double-click file to run 

- Follow installation wizard prompts 

Upgrade Basler Pylon 7.4 

- Install Pylon: 

o Copy the provided file (basler_pylon_7_4_0_14900.exe) to the equipment PC desktop 

o Double-click file to run 



 

 Page 2 of 10 

o Select Camera User under “Profiles”:     

o Select USB, GigE and CXP under “Interfaces”:  

o Follow further prompts to complete installation 

- Unplug all GigE camera cables from the switchbox:  

- Unplug all GigE patch cables (cables that go from the switchbox to the back of the computer) from the back of the 
computer. 

- Plug all GigE camera cables from Shadow Moire, DFP, and DIC cameras (where applicable, as some will be USB3) 
directly into any available ethernet port on the back of the computer. Set the switchbox and patch cables aside as 
they will not be used with Studio 10. 

- Run Pylon Viewer application 

o On First Start-Up “Welcome to Pylon” pop-up is shown 

▪ Select “No” (thumbs down) in response to question “Would you like to participate in our product 
improvement program?” 

▪ Select “Apply” on bottom right 

▪ Uncheck “Show this window on launch” on bottom right 

▪ Select “Close” on bottom right 

o From Pylon Viewer all cameras in use need to be named as follows: 

▪ Shadow Moire camera – “Shadow Moire” 

▪ DFP camera – “DFP” 

▪ DIC cameras – “LeftDIC” and “RightDIC” 

• The RightDIC camera should already have a similar name to tell them apart, otherwise a 
live view can be seen from the interface via “Camera->Continuous Shot” to tell left and 
right DIC camera apart 

▪ To change camera name  

• Click on the camera under the Devices window in the top left 

• Click the On/Off slider button to connect to the camera 
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• For GigE cameras, in the bottom left window, click on the “Device Information” Category

 

• For USB cameras, in the bottom left window, click on the “Device Control” Category 

 

o To the right of Device Information/Device Control double click the text next to 
“Device User ID” and type in the appropriate camera name  

▪ Repeat this process for all cameras in use 

• Note that USB camera names will not be updated in the Devices list until the camera is 
power cycled 

- Pylon IP Configurator 

o Open Pylon IP Configurator and change Right DIC camera to Auto IP from Static 

- Network Connections 

o Open Network Connections settings: Control Panel\Network and Sharing Center\Change adapter settings 

▪ Right click on the lower_adapter and go to Properties 

• Highlight Internet Protocol Version 4 and click the Properties button 

o Change the IP address setting to Obtain an IP address automatically 

Install Matrox MIL X 

Note that the same physical key as Matrox 10 is used here, this is a software change only. Install steps follow: 
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- In Windows start menu type “Apps” to find and open Apps & Features window. Locate and click on Matrox Imaging 
(64-bit) program and click Uninstall. 

- Copy the provided file zip folder (MIL_X_Runtime_Redistribution.zip) to the PC desktop and right click on the zip to 
“Extract” the files 

- In the extracted “MIL_X_Runtime_Redistribution” folder double click to run the MIL64Setup.exe file 

- Uncheck “Play orientation video” in Matrox Imaging Setup screen  

- Click next until “Matrox Image Default Settings” screen is reached 

- Make sure “Host” is selected for “Default System” from the drop down and uncheck all further options 

 

- Hit next and finish wizard 

- Once installation is complete, restart the system PC 
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Install Studio 10 and Software Dongle Exchange 
THIS INSTALLATION INVOLVES REPLACING THE PHYSICAL USB DONGLE THAT PROVIDES THE LICENSE 
INFORMATION FOR THE STUDIO SOFTWARE. See below image of legacy key being replaced and new HL Sentinel Max 
key used for Studio 10.  Note that some customers may already have the green colored HL Sentinel Max key, in which case 
this full section can be ignored. 

 

1. Disable Current USB License:  The current USB Sentinel key that allows Studio to run will no longer be used with 
Studio 10.  To ensure the correct number of software licenses owned by each customer, this key needs to be 
disabled and license report sent to Akrometrix.   

a. Customers will be provided with an “*.akx_update” file.  Download the file to the system or offline PC. 

b. This update should be applied to the current key:  

c. Once applied, the License Report should look something similar to the below image with all text in red and 
“Enabled” as “No” for each row.  Some keys may have more/different entries, depending on system 
configuration. 

 

 

d. Save this report and send to local Akrometrix sales contact.   
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2. Install Studio Software:  Download and Unzip the Studio 10 Installer zip file onto the system PC. Manually uninstall 
all Akrometrix Studio applications via Windows “Apps and Features”, then restart the computer. Install all 
applications for Studio 10 by launching the provided file “Akrometrix Studio 10.0.5 Installer x64.exe”. A full system 
power cycle is required after completing all system and software updates, via the main hardware disconnect on the 
electrical panel. 

3. Plug in the newly provided Sentinel key to any available USB port on the PC. 

4. Update New Sentinel Key:  The newly provided Sentinel key will only function for 2-3 months without being updated.  
Once the report from step 1 has been provided to Akrometrix a key update file will be provided.  To install: 

a. Download the provided “*.akx_keyconfig2” file to the system or offline PC. 

b. This update should be applied to the new Studio key:  

5. Repeat Steps 1-4 for any offline Studio Software keys. 

Key Feature Changes or Additions: 

Studio 10 is releasing without fully updated User Manuals for this version, to be provided at a later date. 

Next Generation Code 

Studio 10 is built on a next generation code framework, setting the table for many new features. These include: 

- Windows 11 support 

- AXP3 support 

- Updated Part Tracking library (further detailed later) 

- Streamlined module switching without unplugging cameras or turning switchbox dials 

- Updated PLC communications increasing speed and reliability 

- DFP2/DIC2 support on PS600S 

DFP2 Improvements 

- DFP can now be run in high bit depth mode on startup, increasing resolution, particularly for unpainted samples 

- DFP phase stepping upgrades have been made to improve resolution and reduce measurement noise 

Part Tracking Improvements 

- Image based Part Tracking can now support image model sizes up to 4096x4096 pixels.   

- Part Tracking inset now allows negative values, allowing creation of larger ROI based on a smaller subset image 
or rectangle model. 

Studio 10 Features: 

- Surface Measurement: 

o Camera window size is now optimized for QHD monitors. Also, users are warned that GUI layout may be 
compromised on screens/resolutions less than 2560x1440 

o Cameras do not need to be unplugged when switching between modules 

o Live View when running DIC can now be suspended when Surface Measurement loses focus, improving overall 
software and PC performance 

o Further GUI improvements to Automated Lens Controller, including establishing presets 
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o Further PC and equipment information written to log to aid in support 

o Part Tracking 

▪ Noise Reduction and Edge Detail functions can now be used for rectangle models 

o DIC Surface Measurement 

▪ Cameras no longer need to be plugged into specific network ports. Instead, names must include the 
words “left” and “right” respectively. 

- Thermal Profiler: 

o Added support and interface for software controlled variable exhaust speed in the software on AXP3 and some 
later AXP 2.0 systems 

▪ Exhaust speed can be controlled via input profile and recorded in output profile table 

▪ New option to allow exhaust to remain on at 10-30% while in heating mode, in order to reduce optical 
distortion effects of heat waves on DFP and DIC measurements 

o Thermal Profile column headers updated and newly added to provide further info on profile settings: (shown 
below in two rows, but will be seen in a single row in the software) 

 

▪ Not all columns are new, but a summary of acronyms is shown here.  All names can be seen by mousing 
over column headers 

BHIP – Bottom Heater Inner Power % Position – Stage Height 

BHOP – Bottom Heater Outer Power % THE – Top Heater Enabled (True/False) 

THP – Top Heater Power % THFT – Top Heater Feedback Thermocouple (1/2) 

CM – Control Mode THSO – Top Heater Setpoint Offset (°C) 

ESL – Exhaust Speed Limit % BHPOL – Bottom Heater Power Output Limit % 

ES – Exhaust Speed % BHIMP – Bottom Heater Inner Max Power % 

BS – Blower Status BHOMP – Bottom Heater Outer Max Power % 

EGS – Exhaust Gate Status  

o Profiles can no longer be started while in Accuracy Check Mode 

o Start Menu Option - Users now have the option to not “Show Warning Dialogs” before ending a profile due to 
an unresponsive thermocouple 

o Sub-Room Module Only 

▪ Added further checks and user information in swapping between Sub-Room and Radiant heating 
modes 

- Surface Analysis 

o Mirror Feature – Users can create a mirrored data set in 1-off, via context menu, or as an option in Batch 
Processing. This mirror can be across the horizontal or vertical axis. 
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o Fill Holes Feature – Users can mathematically fill in holes where mask data exists in 1-off, via context menu, or 
as an option in Batch Processing. 

            

o A new “plane” shape has been added to the options for creating a displacement via File->New Displacement 
or File->New Profile Displacement. A tilt may be optionally added to the plane. 

o Improvements made to loading akx_3dconfig files for those using these files from older versions 

▪ The akx_3dconfig file type is no longer created in Surface Analysis, as key visual settings are now part 
of Tools-Options and Automated Report Generator 

o Detect Features is now disabled when Step Heights, Chords, Mask and/or Partition regions are defined, in order 
to avoid associated errors 

o Multiple improvements made to Phase Bridging context menu options and interface 

o Custom smooth context window now remembers the last used settings 

o Multiple improvements and fixes made to the File Finder feature at Tools->File Finder 
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o Surface annotations can now be seen when using the Save Image function in Surface and Displacement views 

o 1-Off Interface Analysis, chordset and chordmode view are now maintained after analysis instead of being reset 
to Diagonal 

o 1-Off Interface Analysis now sets Gap surface display setting to Solid/Wireframe Off when PWF Map is visible 
to improve readability 

o Batch Processing 

▪ Pin 1 indicator now visible in color contour graphs 

▪ Batch Mask tab – Phase Amplitude can now be filtered by 10-bit greyscale 

o Automated Report Generator 

▪ Required fields are now indicated on test info tab 

▪ Test info tab is now shown as part of the gauge preview 

Key Bug Fixes: 

- Resolved issue with inaccurate lateral resolution and errors when using ChordAngle and ChordROC gauges. 

- Surface Measurement: 

o Saved 3D graph footers now correctly contain PWF info when using RTA 
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o Resolved issue with selected exposure% sometimes affecting dual exposure acquisition results 

o DFP Only 

▪ Calibrating at 100% exposure on longer causes an error if Measurement Frame Rate was recently 
changed 

o TTSM Only 

▪ TTSM-J and TTSM-JS specific Machine Controls no longer vanish when starting a New Recipe 

▪ Load/Unload Position controls are no longer incorrectly shown when assigning grating measurement 
position in recipe editor 

- Thermal Profiler: 

o Extraneous power out% columns are no longer found in saved thermal profile text file 

o Resolved an error generated when TC2 is selected as control thermocouple but also disabled or unplugged 

o Further stability fixes added in generating phase images 

o Resolved a rare case where previously defined temperature profile error bands could replace profile defined 
wait for temperature error bands 

- Surface Analysis: 

o Contour Plots now correctly follow common Z-Scale selection 

o Chord Plots remain correctly normalized after alteration to displacement data 

o Multiple file metadata fields can now be deleted without causing unwanted errors in loading files 

o Save Image function now correctly remembers last accessed directory 

o Resolved issue with labels on inline chord in 1-off Interface Analysis plots 

o Resolved issues with assigning physical dimensions in 1-off Interface Analysis plots 

o Automated Report Generator 

▪ Change Max Number of Roi Locations grouping filter no longer incorrectly resets grouped results 

▪ Clicking on Row/Column Headers while in Room Temp mode no long generates error 

o Batch Interface Analysis 

▪ Files are now correctly shown in Non-Profile mode if they lack Temp Nominal metadata 

▪ PWF Map is now correctly shown on Gap Plots 

▪ Changing a limit no longer resets Gap Mode to Top-Bottom Mode 

Known Issues 

- The File Finder feature under Tools in Surface Analysis has seen limited testing relative to the many different use 
iterations and is expected to still have open issues, particularly with older files. 

- No further known issues are reported at this time. 

Versions (listed for reference): 

Studio Manager  10.0.20293 

SurfaceMeasurement 10.0.20293 

SurfaceAnalysis  10.0.20293 

ProfileGenerator 10.0.20293 

LicenseUtility  10.0.20293 

User Manuals Studio Studio 9.0 


